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Available Manuals

Some manuals are printouts and others are electronic forms, called e-manuals, on the Client Utilities/
User Documentation DVD.

Printouts describe precautions and basic operations. Read the Safety Information before using the
equipment.

e-manuals describe detailed copying functions and other settings.

M Printouts/e-manuals

Safety Information
Describes the necessary precautions for use. Read this booklet first.

Quick Start Guide (This guide)/Basic Operation
Describes the basic operations of the equipment.

Hl How to use the Client Utilities/User Documentation DVD

O Windows:

1. Setthe Client Utilities/User Documentation DVD in the DVD-ROM drive on your computer.
Software Installer starts automatically.

If Software Installer does not launch, use the explorer to open the Client Utilities/User
Documentation DVD and double-click “Setup.exe”.

2. Select [l agree to the terms of the License Agreement.] and click [Next].
3. Click the Open User’s Manual link in Software Installer.
The browser starts automatically and the menu is displayed.

If the menu is not displayed, use the explorer to open the [Manuals] folder in the Client Utilities/
User Documentation DVD and double-click “index.html”.

4. Click the title of the operator’s manual from the menu.

O macoOs:

1. Setthe Client Utilities/User Documentation DVD in the DVD-ROM drive on your computer.

2. Open the [Manuals] folder in the Client Utilities/User Documentation DVD and double-click
“index.html”.

3. Click the title of the operator’s manual from the menu.



Bl e-manuals

Copy
Describes how to use the Copy function.

Scan
Describes how to use the Scan function.

e-Filing
Describes how to use the e-Filing function.

User Functions
Describes how to use the User Functions menu
and Counter menu.

Template
Describes how to use the Template function.

Fax

Describes how to use the Fax function (optional).

Preparation of Paper
Describes how to load paper.

Specifications
Describes the specifications of this equipment
and information on optional devices.

Information About Equipment
Describes the handling of the equipment.

Troubleshooting

Describes causes and solutions for problems
such as paper misfeeds and errors on the touch
panel.

Frequently Asked Questions

Describes frequently asked questions and
actions to be taken for them in the use of the
equipment

Installation
Describes how to install client software such as
the printer driver.

Print
Describes how to use the Print function.

TopAccess

Describes procedures for remote setup and
management from a web-based utility,
TopAccess.

TopAccess is a web utility that allows you to
manage the equipment from a browser.

High Security Mode

Describes the conditions and settings for the high
security mode.

In order to use the equipment by complying with
CC Certification, read this necessarily.

U Operating conditions of the e-manuals

Operation checks have been performed in the following environment.

0S: Windows 10
Browser: Google Chrome (Official Build 64 bit)

H Trademarks

For trademarks, refer to the Safety Information.

l Symbols in this manual

In this manual, some important items are described with the symbols shown below. Be sure to read

these items before using this equipment.

equipment.

Indicates information to which you should pay attention when operating the

Tip Describes handy information that is useful to know when operating the equipment.

©2021 Toshiba Tec Corporation All rights reserved

Under the copyright laws, this manual cannot be reproduced in any form without prior written

permission of Toshiba Tec Corporation.




BASIC OPERATION

Home Screen

H Recalling functions

1 Press the [HOME] button of the control panel.

Tip
The following functions can be recalled as the default.
Simple Copy
Simple Scan
Simple Fax (Optional)
Print
e-Filing
Copy
Scan
Fax (Optional)
User Functions -User-
Language
Counter
Image Recovery



M Registering functions

1

Press the Home Setting button of
the touch panel.

3 PUBLIC HOME

- P

5L A

Enter the administrator password
and then press [OK].

Press [Button Contents].

Press the Page Position indicator to
display the page where you want to
add the button.

Press a button that does not have a
function assigned.

it PUBLIC HOME

Select the function you want and
then press [Confirm].

Press [X] at the top right corner of
the button registration menu
screen.
Example

it PUBLIC HOME

Tip

You can register not only the functions but
also the job settings, URL and applications
in the Home screen. Moreover, you can
remove the registered functions and
customize the buttons (numbers and size),
text (color and size) and background.
Template - REGISTERING JOB SETTINGS
ONTO THE HOME SCREEN

User Functions - APPENDIX - Home Screen
Settings

TopAccess - [Administration] -
[Registration] ([Administration]) Item
List - Image/lcon Management

Excluding the Home screen, you can
customize so that only the necessary
buttons are displayed on the touch panel.
TopAccess - [Administration] -
[Maintenance] Item List - Panel View



Simple Copy

l How to make a copy H Sets

The number of copies can be specified by
pressing [+] or [-] of [Sets]. When you press the
Place the original. number indication, the value can be specified
using the numeric keys.

1
2

3

4

Press [Simple Copy].

Copy Mads & Stop

Specifv the o number of copies :

and color mode and press U112

[Start]. When you press [+] or [-] for a few seconds, the
& value can be increased or decreased in
increments of 10.

Sier Py

H Color Mode

In color models, the color mode can be
specified.

Tip
Press [Stop] if you want to cancel while
copying.
When the original is placed on the

original glass, press [Job Finish] to
finish copying.

& Stop

Tip
There are 3 color modes as shown below. You
can also adjust the density.
Full Color: All originals are copied in full color.
(Default)
Black: All originals are copied in black and
white.
Auto Color: The type of each color on originals
is judged automatically. Colored originals are
copied in full color and black-and-white
originals are copied in black and white.



H Paper/Zoom M 2-Sided

The size of the copy paper and the The duplex setting for the original and copies
reproduction ratio can be specified. When you can be specified.

press [Fit] of [Zoom], the reproduction ratio
corresponding to the paper size is specified.

Select the directions of originals or scanned
images, if necessary.

H Staple

When the Finisher (option) is installed, the
stapling position can be specified.




Simple Scan

l How to make scanning

1 Press [Simple Scan].
2 Place the original.

3 Press [Address Book] and specify
the recipient e-mail address.

Tip
When you press [Address Book], you can
select whether to use a registered e-mail
address or enter an e-mail address
directly.

4 Specify the o color mode or other
items and press [Start].

i ar

Simple Scan sends the scanned data to an e-
mail address. An administrator needs to set up
the equipment in advance.

Tip
When the original is placed on the original

glass, press [Job Finish] after all pages are
scanned.

B Preview

The preview of a scanned image is displayed
after [Start] is pressed. When [Edit] on the
preview screen is pressed, you can change the
page order and edit the pages such as rotating.

Bl Color Mode

The color mode can be specified.

Tip
There are 4 color modes as shown below.
Black: All originals are scanned in black and
white.
Gray Scale: Originals containing both text and
photos are scanned while enhancing the
quality of photos.
Full Color: All originals are scanned in full
color.
Auto Color: Colored originals are scanned in
full color and black-and-white originals are
scanned in black and white by automatically
detecting the color type of each original page.



B File Format

The file format of the scanned data can be )

specified. * There are 4 file formats as shown below.
- JPEG
- PDF
- Secure PDF
- Slim PDF

* [JPEG] is available only when [Full Color] or
[Gray Scale] is selected for the color mode
setting.

Tip

H Resolution

When [Secure PDF] is selected, perform the The resolution can be specified.
encryption setting on the PDF Security
Settings screen.

¢ [User Password]
A password can be set for the encrypted
PDF file(s). This password is asked for when
you open the file.

¢ [Master Password]
A password can be set for changing the
encryption level and authority settings.

* [Encryption Level]

- [256-b.|t AES]: Thisis u§ed to'set to an B 2-Sided Scan

encryption level compatible with Acrobat j ] o

9.0 (PDF Version 1.7). The 2-sided scan setting for the original can be
- [128-bit AES]: This is used to set to an specified.

encryption level compatible with Acrobat
7.0 (PDF Version 1.6).

- [128-bit RC4]: This is used to set to an
encryption level compatible with Acrobat
5.0 (PDF Version 1.4).

- [40-bit RC4]: Thisis used to set to an
encryption level compatible with Acrobat
3.0 (PDF Version 1.1).

* Authority

- [Print]: This is used to authorize users to
print PDF files.

- [Change]: This is used to authorize users
to edit and convert PDF files.

- [Extract]: This is used to authorize users
to copy and extract the contents of PDF Original Directicr
files.

- [Accessibility]: Thisis used to enable the
accessibility feature.

Select the directions of originals or scanned
images, if necessary.




Simple Fax

Bl How to send a fax

1 Press [Simple Fax].
2 Place the original.

on the touch panel
ecipient fax number
numeric keys.

3 Press (1)

and enter
with the

S Fax

Enter the number

Tip

* When you send a fax to multiple
recipients, press [Multi] after the fax
number has been entered.

e Ifanincorrect value is entered, press
[Back Space] to delete numbers one by
one.

e Allthe entered numbers can be deleted
by pressing [Clear].

4 Press [Start].
Tip

Press the [START] button on the control
panel can also send a fax.

10

B Preview

The preview of the scanned image to be sent is
displayed after [Start] is pressed. When [Edit]
on the preview screen is pressed, you can
delete pages.

H Resolution

1 Press [Settings].

2 €D select the resolution and press
[OK].

“a

[Resolution]
The resolution based on the fineness of
the original can be specified.

e Standard: This is suitable for an
original with regular size text.

* Fine: This is suitable for an original
with small size text and fine
illustrations.

* Ultra Fine: This is suitable for an
original with ultra-fine illustrations.



H Original Mode

1
2

Press [Settings].

o Select the original mode and
press [OK].

[Original Mode]
The scanning mode based on the type of
the original can be specified.

* Photo: This is suitable for an original
with photos.

¢ Text/Photo: This is suitable for an
original with a mixture of text and
photos.

¢ Text: This is suitable for an original
with text and line drawings.

M 2-Sided Scan

1

Press [Settings].

o Select the 2-sided scan mode
and press [OK].

Manual

[2-Sided Scan]
The type of the original (1-sided or 2-
sided) to be scanned can be specified.

* 1 Side: This is used for scanning a 1-
sided original.

* Booklet: This is used for scanning a 2-
sided right-to-left (book-type) original.

* Tablet: This is used for scanning a 2-
sided top-to-bottom (tablet-type)
original.

M Original Size

1
2

1
2

Press [Settings].

o Select the original size and
press [OK].

[Original Size]
The scan size of the original can be
specified.

* Auto: The size of the original is
automatically determined before it is
scanned.

e Different Width: This is used when
originals with different width are
loaded on the ADF.

* Specified size: This is used when
originals are scanned at the preset size
regardless of the actual one.

l Exposure

Press [Settings].

(1) Specify the density and press
[OK].

[Exposure]
The scan density of the original can be
specified.

* Auto: The contrast of the original is
automatically detected and it is
scanned with the optimum density.

* Manual: The desired density can be
specified.

11



M Specifying recipientsinthe address M Searching recipients

12

book Press o and enter 9 the keyword.
Recipients including the keyword are
U Specifying recipients one by displayed.
one

Tip
Searching using multiple keywords can be
carried out by dividing them with a space.

O Specifying recipients in groups

Press om and 9 select the recipient.

B Confirming recipients

Press the destination number
indication area.

Tip

2 Check the recipient addresses on

the displayed screen.
¢ When @ is pressed, the address book is y

displayed in the list.

¢ When m is pressed, the recipients
registered in the favorites are displayed.

Tip

Press [X] at the right to delete the
recipients one by one. Press [Clear All] to
deleted all the recipients.



H Confirming the transmission
history and sending a fax

2 The list of the transmission history
is displayed. Select the recipient to
send a fax and then press [Start].

Tip
Up to 40 jobs of the transmission history are
viewed.

H Registering the recipient’s address

1 Select the recipient to be registered
in the address book from the
transmission history list and then
press [Registration].

2 0 Enter the recipient

information. After the
necessary information is entered,

press [OK].

Tip

When m is pressed, the recipient can be
registered in the favorites.

l Searching in the address book

Press on the address book
screen.

3 o Enter the item for searching
and press [Search].

Tip
The address book can be switched and refined
on the address book screen.

Switches to the address book with
recipients registered individually.

Switches to the address book with
recipients registered as a group.

Refines the recipients registered in
the favorites.

Refines the recipients beginning with

8¢ the letter displayed on the button.

Displays the address book in the
button style.

Displays the address book in the list
style.

13



Print

This is for printing from a Windows computer with a Universal Printer 2 driver which needs to be
installed in advance.

l How to make printing

1 Select [Print] in the [File] menu of the application.
o Select the printer driver of the equipment and then 9 click [Preferences]

([Properties])
p .
i Print x
General
Select Printer
= Fax
e S Brinter 2
<
Stetus: Ready Preferences
Location:
Comment Fing Prrtr.
Page Range
@A Number of copies: |1 £
Selection Curent Page
Pages:
Cancel Aopl

Set the print options and click [OK].
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4 Click [Print] ([OK]).

o Print X
Generd
Select Printer
= Fax
G m—— Printer 2
>
Location:
Comment: Find Printer.
Page Range
@A Number of gopies: [1 %
Selection Curent Page
Pages:

To install the printer driver in a Windows computer, see the reference below.
Installation - INSTALLING PRINTER DRIVERS FOR WINDOWS

To install the printer driver in a Mac computer, see the reference below.
Installation - INSTALLING PRINTER DRIVERS FOR macOS

14



l Setting Universal Printer 2 driver

= Printireg Freferences *

Bar  firshen FaperHncivg bags Gty Efect (Shes r..m.]
Prirt job:

Criginal Paper Spe
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Baper Sowce
==
Paper fpn
Pain
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Letter g
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Sating_

Profie Plymber of Caples: -39
e ienzion = &l
SURTIOTE) [ @ Poqimt OLendscape

e L Lelor

Pestoos Defaults 323 A EE;

O To specify paper size or number of copy sets
Click the [Basic] tab.

U To specify 2-sided printing or N-up printing
Click the [Finishing] tab. If the Finisher and the Hole Punch Unit are installed, “Staple” and “Hole
Punch” are available.

Tip
Select “Number of pages per Sheet” to print several pages on one sheet. Pages are reduced to fit the
selected paper size and printed.

2IN1 4IN1

=

U To specify Front cover printing
Click the [Paper Handling] tab.

U To adjust Image quality
Click the [Image Quality] tab.

U To print with character strings or graphics on the background of the
paper
Click the [Effect] tab.

U To skip blank pages
Click the [Others] tab.
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O To print with templates
Click the [Templates] tab.

U Printing documents using the bypass tray

The following explains how to print documents from a computer using the bypass tray.

~No »tnphwWw N

8
9

Select [Print] in the [File] menu of the application.

Select the printer driver of the equipment and then click [Preferences]
([Properties]).

Select the [Basic] tab menu.
Select the document size in [Original Paper Size].

Select the paper size in [Print Paper Size].
If you do not want to enable enlarged or reduced printing, select [Same as Original Size].

Select [Bypass Tray] in [Paper Source].

Select the paper type to be fed from the bypass tray in [Paper Type].

* When printing documents is attempted with thick paper and so on (other than plain paper),
click [Paper Type] to specify the paper type.

* For more information about the paper type, see the reference below.
Specifications - SPECIFICATIONS OF PAPER - Acceptable paper

Set other printing functions as needed and then click [OK].
Click [Print] ([OK]) of the application.

10 Place paper face down on the bypass tray of the equipment.

1 1 Press [Job Status] on the Home screen.

12 When “Select the drawer or bypass tray.” is displayed on the touch panel, press

[Bypass Feed].

1 3 Press the [START] button on the control panel.
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